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Data Topic  Level 

Electron diffraction Determination of absolute structure with 

dynamical refinement 
Beginner 

Introduction 
In this example, we start at the stage after structure solution of the pharmaceutical compound 
abiraterone acetate (C26H33NO2) and we are only interested in the determination of the 
absolute structure. First, we do not refine any structural parameters (only scale factors and 
thickness) of the two enantiomorphs. Even with “slow” computers, this step should be only a 
matter of minutes. We then refine coordinates and isotropic displacement parameters. 
Data reduction, structure solution and kinematical refinement are not part of this example. 

Input data 

Data  

Electron diffraction data were measured on a transmission electron microscope FEI Tecnai G2 
20 (LaB6) with acceleration voltage of 200 kV (λ = 0.2508 Å). The sample temperature was 100 
K. Diffraction patterns were recorded analogous to the rotation method implemented in most 
modern X-ray diffractometers in 0.4° steps, i.e. the goniometer performed a rotation of 0.4° 
while the diffraction patterns were recorded (“continuous rotation”). Several data sets were 
measured. Data reductions were performed with PETS2 (not part of this tutorial). Here, two 
data sets were combined for the structure solution and one of them is used for the dynamical 
refinement. 

Input files  

abiraterone_acetate_solution.cif:    Structure solution generated with SIR 2014 
abiraterone_acetate_03_dyn.cif_pets:    output file from PETS2 
constraints.txt:    list of constraints 
 

Additional information  

- folder “refinements”: intermediate states of Jana files for comparison and as reference 
- used software: Jana2020 (jana.fzu.cz), VESTA (jp-minerals.org/vesta/en/download.html) 

References 
- L. Palatinus et al. Structure refinement using precession electron diffraction tomography and 
dynamical diffraction: theory and implementation. Acta Cryst. A71: 235–244 (2015). 
- L. Palatinus et al. Structure refinement using precession electron diffraction tomography and 
dynamical diffraction: tests on experimental data. Acta Crystallogr B71: 740–751 (2015) 
- terminology of absolute structure: https://dictionary.iucr.org/Absolute_structure 

Instructions 



 

 

1. Create new structure  

Start Jana2020 

In the Main menu bar, use “Structure → New” and open new structure “abiraterone_acetate”  
OPEN 

2. Import Wizard 

[On the screen: Specify type of the file to be imported] 
Select “Structure: from CIF”; NEXT 

 
[On the screen: Data reduction file from] 
Locate “abiraterone_acetate_solution.cif”; OPEN 
CIF file does not contain any reflection block. Do you want to import data from file? 
YES 
[On the screen: Specify type of the file to be imported] 

 
Select “Single crystal: known diffractometer formats”; NEXT  
Select “Pets electron diffractometer” 
“Browse” for the file “abiraterone_acetate_03_dyn.cif_pets”; OPEN 

 
Check “Make the reflection file for dynamical refinement”; NEXT 
Note the wavelength of 0.0251 Å. 
Set temperature to 100; NEXT 
Leave all settings unchanged (no twinning, no modulation); NEXT 
The program reads 19797 reflections. 
OK 
For absorption correction select “None or done before importing”; NEXT 
FINISH; OK; NEXT 
6960 observed and 19797 reflections in total imported. 
OK; OK; FINISH 
We now finished providing the intitial structure model, the reflections list and the diffraction 
geometry. We can have a look at the structure with JanaDraw. 
Start JanaDraw by clicking on the six-ring above the command tree 



 

 

Click “Build molecule” icon (blue hexagon at the bottom) 

 

3. Setup of dynamical refinement 

In the command tree (left), expand “Edit structure parameters” 
→ “Edit parameters for electron diffraction” (double click) 
In the top section on the left: 
Set “Maximal diffraction vector g(max)” to 1.0 
Set “RSg(max)” to 0.6 
Set “DSg(min)” to 0.0025 (Å-1) 
Set “Number of threads” to the number of physical cores of your processor 
In the top section on the right: 
Set “Number of integration steps” to 96 
Set “Geometry” to “rotation” 
In the section in the middle: 
 “except of scale, optimize also”: check “Thickness” 
Click “Run optimizations” 
The dependence of R factors of individual virtual frames on the thickness is determined. This step with an 
8-core processor takes ~3 minutes. The initial thickness estimation is necessary to get a stable starting 
point for the dynamical refinement and to avoid getting stuck in a local minimum. 

 



 

 

 
 
“Show thickness plots” 

 
Close the plot (red X). 
For frames with a well defined minimum, typical thickness values are between 800 and 1200 Å. 
We may set the initital thickness to 1000 Å. A larger thickness means that the rocking curve 
width according to dynamical diffraction theory gets smaller. The numerical integration thus 
requires a finer sampling. Thin crystals (thickness < 400 Å) are sufficiently sampled with about 
30 integration steps per degree (semiangle), but for this case more steps are needed. The 
dependence of the refinement was tested with 30 to 256 integration steps. Convergence was 
observed for about 48 steps. 



 

 

Set “Number of integration steps” to 48.  
Click on “Select zones for editing”; “Select all”; OK. 
The EDThick box is yellow and locked because the parameter is not the same for all selected 
zones. 
Click EDThick box; click Unlock and change the value to 1000. 
This changes EDThick for all zones to 1000 Å. 
Click on “Select zones for editing”; “Refresh”; OK 
By changing number of zone by “Zone#” textbox, we can see that all zones have EDThick 1000 Å 
Uncheck the checkbox “Thickness” 
Click on “Run optimizations” 
This will optimize the scale factor for each frame based on a thickness of 1000 Å. 
OK; YES to save m42 file. 
[ The current state of the Jana files is refinements/step+3_setup ] 

4. Initial determination of absolute structure 

In the command tree (left), expand “Refinement” → “Refinement commands” (double click) 
Set “Number of cycles” to 5 
“Check for convergence”: set “stop if” to 0.4 in 1 consecutive cycles  
Uncheck “Disable atoms having too large ADP parameter” 
Go to Tab “Restraints/Constraints” 
Click “Fixed commands”  
Enter “*” (asterisk) in the field “Atoms/parameters” 
Click “Rewrite”; OK 
This will fix all structural parameters and thus shorten the refinement cycles significantly. 
OK 
[On the screen: “Do you want to save new commands?”] 
YES+START 
The refinement starts. Only the thickness and scales are optimized. With 8-cores, one 
refinement cycle lasts about 30 seconds. 

 
[ The current state of the Jana files is refinements/step+4_refine_thickness ] 
 
Structure (top main menu bar) → Save as 
Save the structure as “inverted_model”; SAVE 
[On the screen: “Do you want to continue with the new structure?”]  
YES 
Transformations (top main menu bar) → Change enantiomorph 
Select “rewrite the old structure”  
OK 
Start JanaDraw (six-ring icon); Build molecule (blue hexagon) 
The shown molecule now corresponds to the other enantiomer and the 
structure model corresponds to the other enantiomorph. 
Double-click “Run refinement” in the command tree  
A single refinement cycle takes about 30 seconds. The scale parameters 
and the thickness change significantly and converge after 3 cycles. 



 

 

 
[ The current state of the Jana files is refinements/step+4_refine_thickness_inverted ] 
 
In comparison to the R factors from before, R(obs) reduced by about 3%, Rall by 2.3% and 
wR2(all) by about 5%. The overall R factors are high because of the limited accuracy of the 
structure solution and thus the change is, on a relative scale, rather small. Nevertheless, the 
overall refinement time was about 6 minutes and the preliminary result is that the structure 
solution provided the wrong absolute structure. In the next step, we will implement constraints 
on the H atoms and refine the corrdinates and isotropic displacement parameters of non-
hydrogen atoms. Note that refinement cycle times will increase significantly (to about 10 
minutes) as we increase the number of refinement parameters. 

5. Hydrogen constraints 

With JanaDraw you can usually easily setup constraints for H positions automatically by 
selecting the relevant atoms and choosing “Adding hydrogen atoms – automatically” from the 

right-click menu. Click the “Add atom labels” icon  to see the site labels. However, the 
structure solution is rather distorted so that the automatic procedure fails to correctly set the 
constraints as the distances and bonding angles deviate too much from the ideal geometry on 
which the automatic procedure is based. You may try the manual approach or a combination of 
automatic and manual approach with a right click on a C atom. Then choose “Adding hydrogen 
atoms – interactively”, click OK in the subsequent menu and then check if the environment was 
correctly detected. In the screenshot below, the geometry and the labels of the carbon atoms 
was correctly determined, but the already placed H site (H13) was not correctly associated. In 
that case, Jana would add a new atom H1C13. If the H atom is correctly associated, the 
hydrogen label is automatically set and no hydrogen atom is added. 

 
 
Here, we will skip this part and simply take a prepared set of constraints to quickly start the 
refinement.  
Open the tutorial file “constraints.txt” with a text editor of your choice 
Select all; Copy (e.g. CTRL + c, or right click and select copy) 
40 lines of "keep" commands should now be in the clipboard. 
In the command tree of Jana2020: Refinement → Refinement commands 
Switch to the tab “Restraints/Constraints” 
Click “Keep commands” 
Click “Edit 



 

 

 
A text editor window opens. It should be empty. If not, remove all lines. 
Text editor: Paste the copied lines from constraints.txt 
With the default notepad text editor, you can use Edit -> Paste (Shortcut: CTRL+v) to do so. 
Text editor: File -> Save 
Text editor: File -> Exit 
The “Define keep commands” window of Jana2020 now lists the keep commands. 
OK 
Note that the “Keep commands” button now is now labelled “Keep commands[40+0]” 
This indicates that there are 40 active “keep” commands and 0 disables ones. 
Click “Fixed commands[1+0!]” 
1+0! Indicates that there is one active “fixed” command and 0 disables ones. 
Select the command line “fixed all *” 
Click “Disable” 
A "!" (exclamation mark) is placed before the command indicating that it is disabled. 
OK; OK 
[ On the screen: Do you want to save new commands? ] 
YES 
[ The current state of the Jana files is refinements/step+5_constraints] 
 

6. Dynamical refinement of correct enantiomorph  

The refinement of the last step only took a few minutes because we limited the number of 
refinement parameters. Refining the coordinates and isotropic displacement parameters of 29 
atoms strongly increases the number of refinement parameters and thus the time for a 
refinement cycle. Like for the previous steps, the Jana files of each step are provided in the 
folder refinements if you only want to check the result without having to wait for the end of 
your own refinement.  
If you follow the final steps of this tutorial, you may expect overall refinement times of at least 
one hour depending on the hardware and on how many refinement cycles you want to see. 
Structure (top main menu bar) → Save as 
Save the structure as “inverted_model_refine”; SAVE 
[On the screen: “Do you want to continue with the new structure?”] 
YES 
Expand “Edit structure parameters” → “Edit parameters for 
electron diffraction” (double click) 
Set “Number of integration steps” to 32 
This number is usually too small. However, for this tutorial the 
convergence behaviour was tested in the range 16 to 128 and 
32 is acceptable for demonstration purposes to speed up the refinement. 



 

 

Make sure that you see the molecule in JanaDraw to follow the structural changes after each 
refinement cycle. The changes are most pronounced after the very first cycle. 
Expand “Refinement” in the command tree→ Double-click “Run refinement”  

 
Jana2020 informs us that constraints will change some angles and distances. In all cases the 
deviation is small. You may look at each message individually by clicking “Use it” until the 
refinement starts. Do not click "Skip it" or "Skip all" because this will disable the respective 
"keep" command(s) for the refinement. 
Click “Use all” to start the refinement 
The wR2(all) after the first cycles are 42.48, 25.09, 23.02, 22.29, 
22.28, 22.23, 22.27, 22.25, 22.22, 22.21 and each cycle lasts about 11 
minutes using 8 cores. Obviously, the largest drop is observed after 
the very first cycle. Though several cycles are needed to achieve a 
fully converged refinement, the R factors of the fourth cycle is already 
representative for the final refinement.  

 
You may stop the refinement anytime you want by clicking “End”. 
Jana will not stop immediately! The current cycle will continue and 
structural parameters refined accordingly. In a (very quick) final run 
the R factors are calculated based on this model. If you click “Cancel”, 
the refinement stops immediately.  
[ The current state of the Jana files is 
refinements/step+6_refine_correct_enantiomorph] 

7. Dynamical refinement of wrong enantiomorph 

We now want to determine the R factors of a refined model of the enantiomorph corresponding 
to the structure solution, which in our initial determination gave a higher R factor. There are 
three ways to do so:  
a) Save as new structure. Invert structure. Set number of integration steps: 48. Start refinement. 
b) open “abiraterone_acetate”, repeat step 5 and 6 
c) open “abiraterone_acetate”, “copy in” constraints from “inverted_model” 
Here we describe the steps of option c). 
Structure (top main menu bar) → Open 
Select “abiraterone_acetate” 
Structure (top main menu bar) → Save as 
Save the structure as “abiraterone_acetate_refine” 
[On the screen: “Do you want to continue with the new structure?”] 
YES 
Structure (top main menu bar) → Copy in 
Select “inverted_model” 
We can now overtake certain Jana files from another refinement. We are now only interested in 
the constraints, which are written in the M50 file. Overwriting M90 and M95 has no effect, 
because the refinements are based on the same data set and data import. M42 contains the 
frame parameters like scales, thickness, their orientation and other paramters of the dynamical 



 

 

refinement. M40 contains the atomic parameters and thus the information on the absolute 
structure. We want to keep the current M40 and M42 file and only overwrite the M50 file. 
Check “Overwrite it?” in the line “m50”. Uncheck all other checkboxes. 

 
We are now ready to start the refinement. Make sure to plot 
the model with JanaDraw if you want to follow the evolution 
of the structural changes during the refinement.  
 “Run refinement”  

   
The wR2(all) after the first cycles are 47.69, 33.87, 31.94, 
31.44, 31.39, 31.30. With more cycles it drops below 31%. 
Note that the structural model is visibly distorted in contrast 
to the model obtained by refining the correct enantiomorph. 
[ The current state of the Jana files is refinements/step+7_refine_wrong_enantiomorph] 

8. Final comparison of R factors 

Model Enantiomorph Robs Rall wR2all 

Solution A 23.93% 34.36% 47.74% 

B 20.84% 32.07% 42.62% 

Refined A 15.91% 25.99% 30.63% 

B 10.65% 20.39% 22.14% 

 
Within the kinematical approximation, the structure was 
solved by SIR (direct methods, screenshot on the right) 
with an R factor of 23.5% based on two data sets. A 
corresponding kinematical refinement (based on the same 
two data sets) converges with R(obs)= 23.74 and wR2(all) 
= 42.39. The absolute structure cannot be determined if 
the kinematical approximation is applied because the R 
factors do not change if the enantiomorph is changed. 
The dynamical refinement is intrinsically sensitive to the 
absolute structure because the dynamical effects, i.e. the 
interaction of several beams being simultaneously 
excited, depend on the absolute structure. This effect is 
completely different to the XRD-based determination of 
the absolute structure ("anomalous dispersion"). 


